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1.1

1.2

1.2.1

1.2.2

1.2.21

1.2.2.2

General Information

Preface

The program MSEEP analyses two-dimensional stationary groundwater flow for a cross section
in layered soil structures, or for phreatic aquifers.

The Finite Element Method is used to solve the differential equation of Laplace, which repre-
sents the stationary groundwater flow. A built-in mesh-generator creates an element mesh for
the geometry.

MSEEP was developed especially for the geotechnical engineer. MSEEP’s graphical interactive
interface requires just a short training period for novice users. This means that you can focus
your skills directly on the input of sound geotechnical data and on the subsequent stability
analysis.

MSEEP is an integrated part of the M-Series. Therefore you can exchange relevant data with
MGeoBase (central project repository), D-SETTLEMENT (transient settlements), D-GEO STABILITY
(stability) and D-GEO PIPELINE (directional drilling). MGeoBase is used to create and maintain
a central project database, containing data on measurements, geometry and soil properties
of several cross-sections. Besides exchange of input data, MSEEP can also import a settled
geometry that was calculated by D-SETTLEMENT or a pore pressure load that was generated
by MSEEP.

Features

Sign agreements

The direction of the positive X-axis is perpendicular to the direction of the gravity, pointing to
the right. The positive Y-axis is opposite to the gravity direction, pointing upwards. The place
of the origin may be chosen freely.

A positive discharge means injection (a well). A negative discharge means extraction (pump-

ing).

Options

Soil profile

< multiple layers. The two-dimensional soil structure can be composed of several soil
layers with an arbitrary shape and orientation. Each layer is connected to a certain soil

type;

¢ sheet piles. It is possible to model vertical sheet piles. The sheet piles are imperme-
able.

Calculation Methods

The program
mseep analyses two-dimensional stationary groundwaterflow for the next two situations:

¢ analysis of vertical two dimensional stationary groundwaterflow in layered soil struc-
tures, taking into account all kinds of boundary conditions, a phreatic surface and inter-
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nal wells or pumps. This option from now on will be referred to as the ‘Cross section’
method;

¢ analysis two-dimensional steady flows in phreatic aquifers. The assumption is that flow
in an aquifer is essentially horizontal and therefore, equipotential surfaces are vertical.
All kinds of boundary conditions can be taken into account. Internal wells or pumps can
be added to the problem. This option from now on will be referred to as the ‘Phreatic
aquifer’ method.

The Finite Element Method is used to solve the differential equation of Laplace, which repre-
sents the stationary groundwater flow. A built-in mesh generator creates an element mesh of
iso-parametric triangles for the geometry.

A direct solution method (LDU-decomposition) is used to solve the set of equations. The final
position of the phreatic surface is found using an iterative process.

For the ‘Cross section method the finite element mesh is adapted each step (see (Verruyt),
(Barends), or (Engering)). For the ‘Phreatic aquifer’ method is permeability is adjusted each
step (see (Bear, 1979)).

Results

As a result of the analysis, MSEEP can present results in a tabular and graphical form.

The tabular report contains an echo of the input data, concise information of the boundary
nodes and (if required) detailed information of the potentails en discharges in each element
node.

You can also view graphical output of the contour plots of the potentials or waterpressures.

History

MSEEP was first developed in 1987/1988 at GeoDelft with the support of both Oranjewoud
BV and the Road and Hydraulic Engineering Division of the Ministry. Version 1.0 was first
released in 1988 and has since been upgraded a number of times, each time adding new
features and improving its users interface to suit the new demands of its users. In version 4.5
(1995) the Phreatic aquifer calculation method was added.

In 2001 version 6.0, the first Windows version of MSEEP was released. The option for display-
ing streamlines has been replaced by options for presentation of velocity vectors and contour
plots. The report presentation was furthermore enhanced.

Version 6.7 (november 2002) contains improvements for geometry definition.

Version 7.3 (2006) is enhanced with erosion calculations (see option Enable erosion design
in Figure 4.1).

Version 14.1 (2014) In this version Dy is renamed into D~y. An option to specify page start
number for report is added. The limiting critical head is removed to certain upper limit (depen-
dent on geometry). Calculation failed in some circumstances; this is fixed in this version.

Version 16.1 (2016) With this version, license(s) can be borrowed for a certain period allowing
working without connection to the licence server (see section 3.2.4 for more information).

MSEEP has shown to be a useful tool in engineering practice for solving relatively simple
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groundwater flow problems. MSEEP is built such that both frequent and infrequent users are
able to use the program. One condition will always remain however: users have to be famil-
iar with the calculation methods to be able to judge whether the program is suitable for the
problem at hand. Furthermore they should always check the results with their own common
sense.

Limitations

There are limitations to the size of some parameters of MSEEP. On the one hand some

of the limitations are made to protect the user from creating too complex problems. On

the other hand these limitations are made due to the finite memory size of the computer.
Geometry:

maximum numbers of geometry nodes : 15.000
maximum number of soil layers : 99
maximum number of geometry points on each layer boundary : 99
maximum number of soil types : 1000
maximum number of sheet piles : 20
maximum number of vertical boundaries : 20

Element mesh:

maximum number of nodes : no limit
maximum number of elements : no limit
maximum number of nodes on the phreatic surface : 350
number of nodes per element : 3
maximum size of the system matrix : 600.000
maximum number of boundary nodes : 200

Boundary conditions:

maximum number of points with a constant discharge : 100
maximum number of points with a prescribed potential : 100
minimal discharge for a seepage node : 10710
minimal discharge to print into the output file : 10712

Other constants in MSEEP:

width of a sheet pile : 0.05m
accuracy of the co-ordinates of the geometry : 0.01m
accuracy of the co-ordinates of the element mesh, nodes,

which lie within this distance, are put together : 0.0001 m
adaptation factor of the phreatic surface each iteration : 0.67

Limitations due to the numerical model

MSEEP has some limitations, which can not be checked sufficiently or which are due to the
solution techniques used in MSEEP. Perhaps some of these limitations will be removed in a
new version or better checks will be provided.

¢ very slanting boundaries, which are almost vertical, will cause badly shaped ele-
ments. Bad elements can cause local water-unbalance. In MSEEP bad elements are
triangles, that are either too flat or thin. The ideal element is an equilateral triangle;

¢ local refinement generates extra (refinements) nodes per element. There is no general
test to check if such a node already exists. This means that a lot of double nodes are
created during refinement. When the mesh menu is left, all the nodes are sorted and
the double nodes are removed;

Deltares 3 of 63



MSEEP, User Manual

¢ aphreatic line can never drop through a layer boundary. MSEEP checks that the minimal
height of the phreatic block will be at least 5% of its original height;

<& for sheet piles, the user has to specify a required length;

<& before any refinement is performed, MSEEP searches for the nearest node of the mesh
at the bottom of the sheet pile;

<& the element mesh will be split from the top of the sheet pile to this bottom. If the user
wants to have a sheet pile with the exact correct length, then it is recommended to
create a fictive layer boundary, which passes through the bottom of the sheet pile;

¢ for internal nodes with a constant discharge or a prescribed potential, MSEEP
searches for the nearest nodal point in the mesh;

< if there are any internal nodes with a constant discharge or a fixed potential, no stream-
line calculation can be performed;

< boundaries or internal nodes with a fixed potential are treated with a penalty method in
the system matrix. This can cause a slight inaccuracy in the solution;

¢ internal nodes will always have an internal discharge equal to zero, unless a well or
pump is prescribed for this node. This is also valid for a phreatic surface, without rain
when sufficient adjustments are performed;

¢ only if the iteration process is aborted there will be local water unbalance. The user has
to check if this local unbalance is small in comparison to the total in- and outflow;

<& for an extra streamline calculation, a water unbalance in the potential calculation causes
an unbalance in the streamlines;

<& application of MSEEP is allowed as long as the two-dimensional plane-strain assumption
is valid.

1.5 Minimum System Requirements

The following minimum system requirements are needed in order to run and install the
mseep software, either from CD or by downloading from the Deltares Systems website via
MS Internet Explorer:

¢ Operating systems:
0 Windows 2003,
0 Windows Vista,
0 Windows 7 — 32 bits
0 Windows 7 — 64 bits
0 Windows 8
<& Hardware specifications:
O 1 GHz Intel Pentium processor or equivalent
512 MB of RAM
400 MB free hard disk space
SVGA video card, 1024 X 768 pixels, High colors (16 bits)
CD-ROM drive
Microsoft Internet Explorer version 6.0 or newer (download from www.microsoft.com)
For use of the Feasibility module an Internet connection is needed.

O 0000 a0O0

1.6 Definitions and Symbols
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p, 0y  pOre water pressure
D medium grain size
%) potential or piezometric/hydraulic head
g acceleration of the gravity
k., permeability in x-direction
k, permeability in y-direction
P water pressure
q discharge per unit width in the aquifer
Q prescribed discharge along the boundaries or internal sources
p unit weight of the fluid
T, transmissivity in x- and y-direction
v viscosity water
Y elevation head
Getting Help

From the Help menu, choose the Manual option to open the User Manual of
mseep in PDF format. Here help on a specific topic can be found by entering a specific word
in the Find field of the PDF reader.

Clicking on the Help button situated at the bottom-right side of a window will open the User
Manual.

Getting Support

Deltares Systems tools are supported by Deltares. A group of 70 people in software develop-
ment ensures continuous research and development. Support is provided by the developers
and if necessary by the appropriate Deltares experts. These experts can provide consultancy
backup as well.

If problems are encountered, the first step should be to consult the online Help at

www.deltaressystems.com menu ‘Software’. Different information about the program can be
found on the left-hand side of the window (Figure 1.1).
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MSeep

¢ Back to software

Features

Demo / Screenshots >

Service packages H
Other related software N In delta areas the land is protected from floods and high tides by dikes. In general
these are constructed of impervious clays and built on a sandy aquifer as subsoil.
b Such structures are vulnerable to an erosion effect called piping. The actual word
ocumentes

‘piping’ refers to the development of shallow channels in the sand below the dike,

&  Paper - Numerical computation of =
which begins at the downstream side of the structure. Here often a ditch is situated
with a burst bottom due to excess water pressures. The subsequent erosion process
develops backwards to the high head side. The natural nonhomogeneity in the soil
causes the shallow channels to be irregularly shaped. Below a critical value of the
hydraulic head over the structure the erosion process eases down until water only is
transported through the channels. It is common to observe sand boils behind the dike,

which produce water alone. However, if a critical head difference is reached, the

erosion process continues and the structure may in the end collapse.

Figure 1.1: Deltares Systems website (www.deltaressystems.com)

If the solution cannot be found there, then the problem description can be e-mailed (preferred)
or faxed to the Deltares Systems Support team. When sending a problem description, please
add a full description of the working environment. To do this conveniently:

<& Open the program.

< If possible, open a project that can illustrate the question.

& Choose the Support option in the Help menu. The System Info tab contains all relevant
information about the system and the software. The Problem Description tab enables a
description of the problem encountered to be added.

Support (=]
Deltares DeltaresSystems
7 Rotterdamseweqg 185 FPhone: +31 88 335 8100
, P.0.Box 177 Fax: +31 8833581 11
ML-2600 MH Delft E-mail: support@deltaressystems.nl

Systern Info  Problem Description

Please explain your issue here...

Send | Print.. | Save As | Close | Help |

Figure 1.2: Support window, Problem Description tab
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<& After clicking on the Send button, the Send Support E-Mail window opens, allowing
sending current file as an attachment. Marked or not the Attach current file to mail
check-box and click OK to send it.

Send Support E-Mail @

This problem reportwill be sentto "suppon(@deltaressystems.nl".
“w'ou can also send the current file as an attachment. Check the
checkbox belowto do this.

Sending of the problem report with E-mail is only possible if the mail
program on your system is configured as "default Simple MAFI
client" {consultyour systern administrator).

This will only work if wour E-mail program can reach external (Internet)
E-mail addresses.

[~ Attach currentfile to mail

Cancel

Figure 1.3: Send Support E-Mail window

The problem report can either be saved to a file or sent to a printer or PC fax. The document
can be emailed to support@deltaressystems.nl or alternatively faxed to +31(0)88 335 8111.

Deltares

Since January 1%¢ 2008, GeoDelft together with parts of Rijkswaterstaat /DWW, RIKZ and
RIZA, WL |Delft Hydraulics and a part of TNO Built Environment and Geosciences are form-
ing the Deltares Institute, a new and independent institute for applied research and special-
ist advice. Founded in 1934, GeoDelft was one of the world’s most renowned institutes for
geotechnical and environmental research. As a Dutch national Grand Technological Institute
(GTI), Deltares role is to obtain, generate and disseminate geotechnical know-how. The in-
stitute is an international leader in research and consultancy into the behavior of soft soils
(sand clay and peat) and management of the geo-ecological consequences which arise from
these activities. Again and again subsoil related uncertainties and risks appear to be the key
factors in civil engineering risk management. Having the processes to manage these uncer-
tainties makes Deltares the obvious Partner in risk management for all parties involved in the
civil and environmental construction sector. Deltares teams are continually working on new
mechanisms, applications and concepts to facilitate the risk management process, the most
recent of which is the launch of the concept "GeoQ" into the geotechnical sector.

For more information on Deltares, visit the Deltares website: www.deltares.nl.

Deltares Systems

Deltares Systems is a Deltares company. The company’s objective is to convert Deltares’s
knowledge into practical geo-engineering services and software. Deltares Systems has de-
veloped a suite of software for geotechnical engineering. Besides software, Deltares Systems
is involved in providing services such as hosting online monitoring platforms, hosting on-line
delivery of site investigation, laboratory test results, etc. As part of this process Delft GeoSys-
tems is progressively connecting these services to their software. This allows for more stan-
dardized use of information, and the interpretation and comparison of results. Most software
is used as design software, following design standards. This however, does not guarantee
a design that can be executed successfully in practice, so automated back-analyses using
monitoring information are an important aspect in improving geotechnical engineering results.
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Deltares Systems makes use of Deltares’s intensive engagement in R&D for GeoBrain. Geo-
Brain’s objective is to combine experience, expertise and numerical results into one forecast,
using Atrtificial Intelligence, Neural Networks and Bayesian Belief Networks. For more in-
formation about Deltares Systems’ geotechnical software, including download options, visit
www.deltaressystems.com or choose the Deltares Systems Website option from the Help
menu of

mseep.

Rijkswaterstaat

Rijkswaterstaat (RWS) is part of the Dutch Ministry for Traffic, Public Works and Water Man-
agement. RWS’s tasks include the regulation, construction, management and maintenance
of public works. By supporting the development of

mseep, RWS is facilitating the uniform and reliable design of sheet pile walls.

For more information on RWS, visit www.minvenw.nl.

On-line software (Citrix)

Besides purchased software, Deltares Systems tools are available as an on-line service. The
input can be created over the internet. Heavy duty calculation servers at Deltares guarantee
quick analysis, while results are presented on-line. Users can view and print results as well
as locally store project files. Once connected, clients are charged by the hour. For more
information, please contact the Deltares Sales team: sales@deltaressystems.nl.
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2.2

2.2.1

Getting Started

This Getting Started chapter aims to familiarize the user with the structure and user interface
of
mseep.

Starting MSEEP

To start MSEEP, click Start on the Windows taskbar, or double-click a MSEEP input file that
was generated during a previous session. When you start MSEEP from the Windows taskbar,
the last project you worked on will open automatically. MSEEP will display the main window
[section 2.2].

Main window

When you start MSEEP, the main window is displayed. This window contains a menu bar
[section 2.2.1], an icon bar [section 2.2.2] and an Input View window [section 2.2.3] that
shows the pre-selected or the most recently accessed project. The first time after installation
of MSEEP, the Input View window will be closed.

The menu bar

To access the MSEEP menus, click the names on the Menubar.

The menus contain the following functions:

File Standard Windows options for opening, saving and sending files as well
as several MSEEP options for exporting and printing the active window.
[section 3.1]

Project Definition of the calculation type (Model), options for Project Properties
and View Input File [section 4.1].

Soil Definition of soil type properties [section 4.2].

Geometry Definition of layers, soil types and piezometric lines [section 4.3].

Geo-objects
Water

Definition of the Discharges, Potentials and Sheet Piles [section 4.4].
Options for input of water unit weight of water [section 4.5].

Calculation Starts the calculation [chapter 5].
Results Graphical or tabular output of the calculation results [chapter 6].
Tools Options for editing MSEEP program defaults [section 3.2].
Window Default Windows options for arranging the MSEEP windows and choos-
ing the active window.
Help Online Help [section 3.3].
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2.2.2 Theicon bar

You can use the buttons on the icon bar to quickly access frequently used functions.

Click on the following buttons to activate the corresponding functions:
Start a new MSEEP project.

[

Open the input file of an existing project.

Save the input file of the current project.

Print the contents of the active window.

Display a print preview.

Y T n T

Open the Project Properties window. Here you can enter the project title and

other identification data, and determine the View Layout and Graph Settings for
your project.
Start Calculation
Display the contents of online Help.

7

2.2.3 Input View

The Input View window displays the geometry and additional MSEEP input of the current
project.

The panel at the left side of the view contains buttons related to input data and buttons to con-
trol the graphical view. Click on the following buttons to activate the corresponding functions:
- Select mode

3 In this mode you can graphically select a previously defined grid, load, geotextile
or ‘forbidden line’ in the Input View, with the left mouse button. You can then
delete the item or modify the properties via dragging, resizing or a menu that
appears when clicking the right mouse button.
Zoom in
fﬂ Enlarge the drawing

Zoom out
f}l Reduce the drawing size

Zoom area

Undo zoom
K2 K0 | Restore the previous view
Q o P

Zoom limits
Show the complete drawing
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Getting Started

Input

In this view the prescribed discharges and potentials will be shown in the geometry.

Boundary Conditions

Successively the next two steps must be passed:

1 Line menu : Boundary conditions along the borders of the geometry.

2 Node menu: Definition of the conditions to apply at intersection nodes between bound-

ary lines with different conditions.

ad 1: Lines menu

Using the geometry data, the outer border of the geometry will be diveded into several pieces.
This is done by looking at the top layer and the bottom layer of the geometry.

The left limitation of the geometry forms
the first part, after which each part will
be treated clockwise.For each part of
the boundary the following conditions
can be specified

Impermeable boundary, no in- or outflow.

Boundary with discharge

A constant discharge will be divided on all the
nodes of this boundary.

Boundary with potential

A fixed potential will be applied on all the nodes
of this boundary.

Phreatic/Seepage Boundary*

The position of the nodes on this boundary will
be adapted until the potential is greater than or
equal to the elevation head.

If the nodal point lies on the slope and the po-
tential becomes greater than its elevation head,
a seepage will occur.

If the potential is less than the elevation head,
the position of the node will be changed until the
potential is equal to the elevation head.

With vertical boundaries, the above mentioned
process is only valid for the top node.

All the nodes between get a fixed potential equal
to their elevation head (it is a seepage face!).

Phreatic/Closed Boundary*

As above, except when the potential is greater
than the elevation head. There will be no outflow
of the fluid (no seepage), in other words there
can be an overpressure on that boundary.

Overtopping Boundary

Along this boundary, all the nodes get a potential
equal to the elevation head.

Next Boundary line

The default value of the last specified condition
will remain, and the next line
selected.

Exit lines menu

End boundary condition input on boundary lines
and continue with Node Menu.

* : These types of conditions are not available for the ‘Phreatic aquifer’-method.

Deltares
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Note: For the Phreatic/Seepage boundary a rainfall in [meters/year] can be specified. Nor-
mally this rainfall has hardly any influence on the phreatic surface. The rainfall will be divided
on all the nodes of this boundary.

ad 2: Node menu

For all the intersection points on the borders, where the conditions differ on both sides, a
selection must be made to which boundary this point belongs.

For vertical boundaries special attention has to be given to the point at the top. When the
vertical boundary has a so-called ‘closed condition’, and the boundary to the left or to the
right has a Phreatic/seepage boundary condition, the intersection point node has to belong to
the phreatic surface for it will be able to move.

A picture will be drawn on the screen showing the boundary conditions. For each type of
condition another line type will be used. Pumps, wells and potential-points are also drawn at
their specified position (which may differ from the position they will have in the mesh).

Note: IMPORTANT

If the geometry is changed, there may be new boundaries. The user has to check all the
boundary conditions, before a calculation is performed. Only limited tests can be made during
the test-phase of a calculation.

Mesh

To create a mesh, the global element height along the left and right side of each layer has
to be specified [the unit is meters]. Furthermore a height/width ratio for the elements in each
layer can be given between 0.1 and 10.0. A ratio of 10 gives high and thin elements and a
ratio of 0.1 gives thin, flat elements. It is recommended to use a ratio between 0.25 and 4.0.

The generated mesh consists of triangles with three nodes per element.

If an error is found, or when the number of elements or nodes exceeds the maximum num-
ber, an ERROR-MESSAGE will appear on the screen after which the system returns to this
submenu.

At the position where a sheetpile is specified, double nodes are created and the elements on
both side of the sheetpile are disconnected. The data of the sheetpile is shown on the screen,
with the calculated length of the sheetpile, which depends on the coarseness of the mesh.
The bottom node of the sheetpile will be on the nearest node of the mesh, in relation to the
specified length.

To be sure that the required length is more or less equal to calculated length of the sheetpile,
there is the possibility to create a dummy layer boundary at the bottom of the sheetpile.
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Getting Started

Generate Mesh

All actions to generate an element mesh are now performed. If the user returns to the previous
menu, the mesh will be renumbered along verticals to get a minimal bandwidth. This means
a minimal bandwidth for geometries most often encountered in geotechnics: large width and
small height.

The boundary nodes of the mesh will be determined.

Finally the program checks the created mesh by checking if the following formula holds:

ne=2x (nk—1) —nr (2.1)
where:
ne number of elements
nk number of nodes
nr number of boundary nodes

In addition the contact-matrix, needed to solve the set of equation by the LDU-decomposition
method, is made.

Sometimes an ERROR MESSAGE can occur on the screen:
‘Problem too big’.

This means that due to the geometry and the number of nodes in the mesh, the system matrix
is full meaning that the problem is too big for MSEEP. The user has to reduce the number of
nodes and elements.

Note: When a phreatic boundary is specified, the user has to take into account, that the mesh
in the top layer will be adapted (‘breathing’). In other words, the finite element mesh deforms.
The bottom boundary of this ‘breathing’-bloc of the mesh is the underlying layer boundary.

Sometimes it is recommended to create a fictive layer boundary, to have a better bottom
boundary of this phreatic element bloc (see Demo-1).

Check Mesh

With this option a check is performed on the generated mesh. At this moment the only
check performed is a check on bad shaped elements. These are elements that have a bad
height/width ratio (greater than 1:3). In MSEEP these elements do not have a negative influ-
ence on the calculation .

Files

*.sei Input file (ASCII):
Contains the MSEEP specific input. After interactive generation, this file can be
reused in subsequent MSEEP analyses.

*.geo Input file (ASCII):
Contains the geometry data that can be shared with other D-Series programs.

*.gem Mesh file contains the finite element mesh.

*.set Working file (ASCII):
Contains settings data.

*.sed Dump file (ASCII):
Contains an echo of the input and the calculation results
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3 General

3.1

This part of the manual contains a detailed description of the available menu options for input,
calculation and viewing results.

The examples in the tutorial section provide a convenient starting point for familiarization with
the program.

File menu

Besides the familiar Windows options for opening and saving files, the File menu contains a
number of options specific to MSEEP:

<

<

<

copy active window to clipboard Use this option to copy the contents of the active
window to the Windows clipboard so that you can paste them into another application;

export active window Use this option to export the contents of the active window as a
Windows Meta File (*.wmf), a Drawing Exchange File (*.dxf) or a text file (*.txt);

page setup The Page Setup option in the File menu allows you to define the way you
want to print

mseep plots and reports. Here you can define the printer, paper size, orientation and
margins. For plots, you can also specify whether and where axes are required. Click

Atofit o get

mseep to define how the data can best fit on the page;

print preview active window Display a preview of the printout of the current contents
of the Outline View window;

print active window Print the current contents of the Outline View window.

3.2 Program Options menu

On the Menubar, click Tools and then choose Options to open the corresponding input window.
In this window, you can optionally define your own preferences for some of the program’s
default values.
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3.2.1 Program Options — View

& Program Options

I General ] Locations | Modules

v Toolbar
¥ Status bar

[™ Title panel

oK Cancel

Figure 3.1: Program Options window, View tab

Toolbar Indicate whether the toolbar and/or status bar must be displayed

Status bar each time you start MSEEP.
Title panel Mark this check-box to display the project titles, as entered on the
Identification tab of the Project Properties window, in the title panel

at the bottom of the View Input window.

3.2.2 Program Options — General

& Program Options

Locations | Modules

“Wiew
Startup with Sawe on Calculation
 No praject & Alweys Save

' Lastused project ' Always Save As

" New project

Use Enter key to
* Press the default hutton (Windows-style)

" Setfocus to the next contral (DOS-style)

oK Cancel | |

Figure 3.2: Program Options window, General tab
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General

Startup with Click one of these toggle buttons to determine whether or not a
project should be opened or initiated when you start

mseep.

No project: Each

time you  start

MSEEP, you must

use the buttons in

the toolbar or the

options in the File

menu to open an

existing project or

start a new one.

Last used project:

Each time you start

MSEEP, the last

project you worked

on is opened auto-

matically.

New project: When

you start MSEEP, a

dialog is displayed,

allowing you to

enter data for a new

project.

Use Enter key to The toggle buttons allow you to determine the way the Enter key is
used in MSEEP, either as an equivalent of pressing the default button
(Windows-style) or to shift the focus to the next item in a window (for
users accustomed to the DOS version(s) of the program).

Save on calculation  The toggle buttons determine how input data is saved prior to cal-
culation. You can either save the input data automatically, using the
same file name each time, or you can specify a file name each time
the data is saved.

3.2.3 Program Options — Locations

24 Program Options @

Wiew I General L ::§|Mudules.
W Save lastused current directony s working directary

Wiorking directary
‘D \SupportySeepiMSE-273\Support 24Supportihd

™ Use MGeobase database

tMGeobase database

]

Figure 3.3: Program Options window, Locations tab
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Working directory

Use MGeobase
database

You can either automatically make the last used directory your work-
ing directory, or you can specify a default path.

Enable this check-box to specify the location of the MGeoBase
database with material data, geometric data etc. Use of this option
also requires once-off local installation of Interbase client software,
assuming that the database is residing on a server on which server
software has already been installed.

3.24 Program Options — Modules

Program Options

Wigw I Genera\l Locations MD ES

License LFM

¥ tSeep (Steady state)
¥ Piping and heave
¥ Evaluation mode

Mo modules borrowed Return borrow | Borrowing ‘
| Show at start of program Users
Ot Cancel ‘ ‘

Figure 3.4: Program Options window, Modules tab

Click this button to see which modules are (at this moment) in used and
Users who (within the company) is using them.

Click this button to borrow the selected modules for a certain period. The

Borowing.. modules will be taken from the server pool and will be available on this

Feturn borrow

g

3.3 Help menu

computer even if no connection to the license server is available. Set the
date and time for the expiration of the borrowing and press OK.

Click this button to end the borrow immediately.

The Help menu allows access to different options.

3.3.1 Manual

Select the Manual option from the Help menu to view the manual.

3.3.2 Verification Report

Select the Verification Report option from the Help menu to view the verification report.
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3.3.3 Deltares Systems Website

Select Deltares Systems Website option from the Help menu to visit the Deltares Systems
website (www.deltaressystems.com) for the latest news.

3.3.4 Support

Use the Support option from the Help menu to open the Support window in which program
errors can be registered. Refer to section 1.7 for a detailed description of this window.

3.3.5 About MSEEP

Use the About option from the Help menu to display the About MSeep window which provides
software information (for example the version of the software).
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4 Input

Before the analysis can be started, the data for layers, soil properties and loads need to be
inputted through via menus:

< Project menu [section 4.1]. To enter a project identification and to alter default project
settings;

¢ Soil menu [section 4.2]. To define the properties of the soil types;

& Geometry menu [section 4.4]. To add the MSEEP-specific geometry data on the slip
plane and optional geotextiles;

¢ GeoObjects menu [section 4.4];

¢ Water menu [section 4.5]. To define the degree of consolidation, modify the unit weight
or import pore pressures from a MSEEP analysis;

¢ Calculation menu [chapter 5]. To start the determination of the critical slip circle and
the stress distribution along the plane;

& View results menu [chapter 6]. Inspect the location of the critical circle and the distri-
bution of different stress and pressure components along the slip plane.

You can use the examples chapter 8 as a convenient starting point for your own project.

4.1 Project menu

On the menu bar [section 2.2.1], click Project to display the following menu options:

¢ Calculation type [section 4.1.1];

<& Properties [section 4.1.2] to enter a project identification and change the default set-
tings for data visualization. The default project settings will be sufficient for regular
stability analyses;

¢ View input file [section 4.1.3] to inspect the ASCII input file of MSEEP;

< View mesh file [section 4.1.4].

411 Project — Model

Model ==

Model
" Steady state model - phreatic aguifer

* Steady state model - cross section - adapted mesh§

Erosion
[~ Enable erosion design

oK | Cancel

Figure 4.1: Model window
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There are two possible calculations:

¢ Steady state model - phreatic aquifer;
¢ Steady state model - cross section - adapted mesh.

MSEEP simulates two dimensional stationary groundwater flow in a cross section of layered
soil structures (Steady state model - phreatic aquifer model) or in one phreatic aquifer, com-
posed of different material areas (Steady state model - cross section - adapted mesh model).

If the second model is used, the option Enable erosion design can be marked to determine
Piping and Heave. The functioning of this option (input/output/background) is completely de-
scribed in a separate document (“Dijkontwerp tegen Sijperosie met MSEEP Versie 77, in Dutch)
available on demand.

Project — Properties

On the Menu bar [section 2.2.1], click Project and then choose Properties to open the input
window. The Project Properties window contains the following six tabs, on which you can
change different settings for the current project:

Project Properties — Identification
You use the Identification tab to specify the project identification data.
Titles Use Title 1 to give the calculation a unique, easily recognizable name. Title 2

can be added to indicate specific characteristics of the calculation. Both titles
will be included on printed output.

Date The date entered here will be used on printouts and graphic plots for this
project. You can either use the current date on each printout or enter a specific
date.

Drawn by  Enter the name of the user performing the calculation or generating the print-
out.

Project ID  Enter your project identification number.
Annex ID  Specify the annex number of the printout.

Mark the checkbox Save as default if you want to use the current settings every time you start
MSEEP.

Project Properties — Input View

You use the Input View tab to select the visible data in the main window and the Input View
window [section 2.2.3]

Display

Title panel Mark this checkbox to display the title panel with the project titles at the
bottom of the Outline View window.

Info bar Mark this checkbox to display the information bar at the bottom of the

Outline View window.
Sample scale for Mark this checkbox to use the same scale for x and y axis.

X and y axis

Layer Colors Mark this checkbox to display the layer colors.

Rulers Mark this checkbox to display the rulers.

Origin Mark this checkbox to display the origin.

Large cursor Mark this checkbox to use the large cursor instead of the small one.
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4.21

Input

Points Mark this checkbox to the display the points.

Discharges Mark this checkbox to display the discharges.

Potentials Mark this checkbox to display the potentials.

Sheet Piles Mark this checkbox to display the sheet piles.

Mesh Mark this checkbox to display the mesh.

Labels

Points Mark this checkbox to display the point numbers, discharge numbers,

potential numbers, sheet pile numbers and the layer numbers
Layers
Choose either the layer numbers, material numbers or material names to display.

Mark the checkbox Save as default if you want to use the current settings every time
you start MSEEP.

Project — View Input File

On the menu bar [section 2.2.1], click Project and then choose View Input File to display an
overview of your input data.

The data will be displayed in the MSEEP main window. Click % to print the file.

Project — View Mesh File

On the menu bar [section 2.2.1], click Project and then choose View Mesh File to display an
overview the mesh data.

The data will be displayed in the MSEEP main window. Click % to print the file.
The mesh-file is a standard file at Deltares.
The file has the following structure:

<& number of nodes, number of elements;

¢ the node numbers with x- and y-coordinates;

¢ the element numbers with their layer number and the three node numbers forming the
element.

Soil Menu

Soil — Materials

The Soil-Material option in the Soil menu gives access to the input window to define the soil
type properties. The soil types themselves have been defined during the geometry modeling
[chapter 7].

In the table presented here, the permeability in x- and y-direction can be specified in [m/s] for

up to 40 different kinds of soil types. Each soil type must be given an unique name. You have
to define at least 1 soil type but you are free to add more (up to 40).
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The number of soil types do not have to be equal to the number of layers within your geometry.
You may define less soil-types when one soil type can be used for more than one layer. You
can also define more soil types to be able to quickly change soil types per layer for alternative
calculations.

When defining the geometry layers, you can select the soil type for a specific layer from a
list containing all the names of the soil types entered here. This list will be maintained and
provided by the program itself.

The lower limit for the permeability is 107'°m/s.

Geometry menu

On the menu bar, click Geometry to display the menu options. These options are explained
in the following sections.

New (section 4.3.1). Start creating a new geometry manually.

New Wizard (section 4.3.2). Create a new geometry using a wizard.

Import (section 4.3.3). Import a (settled) geometry file in the Deltares exchange format.
Import from database (section 4.3.4). Import a geometry from an MGeobase database.
Export (section 4.3.5). Save a geometry file for exchange with other Deltares Systems
Geo-programs.

Export as Plaxis/Dos (section 4.3.6). Save a geometry file in a different format.
Limits (section 4.3.7). Set the range of the horizontal co-ordinates.

Points (section 4.3.8). Add or manipulate points.

Layers (section 4.3.9). Define or modify layer boundaries and corresponding soil types.
Check geometry (section 4.3.10). Check the validity of the geometry.

C OO0

COOO 0

Geometry — New

Select this option to display the View Input window (Geometry tab), showing only the geom-
etry limits (with their default values) of the geometry. It is possible to now start modelling the
geometry.

However, it is possible to create a new geometry faster and easier using the Geometry Wizard.
This wizard involves a step-by-step process for creating a geometry.

Geometry — New Wizard

To use the geometry wizard, open the Geometry menu and choose New Wizard. This option
will guide the user step-by-step through the process of creating a geometry. Using this wiz-
ard significantly reduces time and effort required to enter data. The wizard uses predefined
shapes and soil types. If more flexibility is required, the View Input window (Geometry tab)
can also be used (section 7.3) in a more general way.

New Wizard — Basic Layout

24 of 63 Deltares



Input

ﬁ

Define measurements basic lapout

i J Ground Level
Phreatic Level

Layer N

Limit Left Lirmit Right

Lirrit left [m] |0.00

Lirriit right [m] |75.00

Mumber of layers [max. 10] [-] |5—
Ground lewvel [m] |0.00

Phreatic: level [m] |-1.00

Mest » I Cancel | Help |

Figure 4.2: New Wizard window, Basic Layout

In the first screen (Basic Layout) of the New Wizard window, the basic framework of the project
can be entered. The graphic at the top of the window explains the required input. When satisfy
with the input, just click the Next button to display the next input screen.

New Wizard — Shape Selection

ﬁ

Select top laver shape by clicking on the desired picture

<Previous| Mext » | Cancel | Help |

Figure 4.3: New Wizard window, Top Layer Shape screen

In the second screen (Top Layer Shape) of the New Wizard window, one of nine default top-
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layer shapes can be selected. A red frame indicates the selected shape. Click the Previous
button to return to the Basic Layout screen, or the Next button to display the next input screen
with shape-specific input data.

New Wizard — Shape Definition

MNew Wizard

Define measurements for top layer shape

L1 L2L3 L4 LS LE L7 L& L9

W1 [m]

250 O (m [280 L6 [m [600
K2 [m] [250 L2 [m [200 7 (ml [1z80
R (m [lO0 L3 (m [a00 L& [ml [300
he [ml L0 L4 [m] [400 s (m [250

L5 [m] |8.00

< Previous | Cancel | Help

Figure 4.4: New Wizard window, Top Layer Specification screen

In the third screen (Top Layer Specification) of the New Wizard window, the sizes for the
selected top layer shape can be specified.

New Wizard — Material types
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MNew Wizard @
Set material types Set all layers to material type
Layer Mr. Material Type Soft Clay -
1 |Grave| j
2 Soft Clay -
| J Apply
3 |Loose Sand j
4 |F'eat ﬂ
Show properties of material type

5 | Derse Sand j

Soft Clay -

Properties

< Previous | Canicel | Help

Figure 4.5: New Wizard window, Material types screen

In the fourth screen (Material Types) of the New Wizard window, the materials used for the
layers in the project can be specified. The number of layers was defined in the first screen
(Basic Layout). The materials that can be chosen from are predefined and given in Table 4.2.

Table 4.2: Predefined materials in MSEEP

Material type Unsaturated weight Saturated weight
[kN/m3] [kN/m3]
Muck 11 11
Peat 12 12
Soft Clay 14 14
Medium Clay 17 17
Stiff Clay 19 19
Loose Sand 17 19
Dense Sand 19 21
Sand 18 20
Gravel 18 20
Loam 20 20

The materials for each layer can be selected individually (using the selection boxes at the
left-hand side of the screen) or one material for each layer can be selected at once (using the
selection box at the top right of the screen). The parameters of each material can also be
reviewed.

New Wizard — Summary
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MNew Wizard @
B azic layout
Lirnit Left [m] 0.00
Limit Right [m] 75.00
Mumber of Layers [-] I}
Ground Lewvel [ MAP] 0.00
Phreatic Level [ MAF] -1.00
Top layer
h1 [m] 250 L1 [m] 2.50
L1 L2L3 L4 LS LE L7 L& L3 b2 [m] 250 L2 [m] 200
h3 [m] 1.00 L3 [m] 8.00
hi hd [m] 1.00 L4 [m] 4.00
LS [m] 8.00
h2 LE [m] E.00
L7 [m] 1250
S i L& [m] 2.00
L9 [m] 250
Material types
Layer1: Gravel
Lawer2:  Saft Clay
Layer 3:  Loose Sand
Layer4: Denze Sand
Layer5: Peat
< Previous | i Finish ¢ Canicel | Help

Figure 4.6: New Wizard window, Summary screen

The last screen (Summary) of the New Wizard window displays an overview of the data
entered in the previous wizard screens. If necessary, click Previous to go back to any screen
and change the data as required. Click Finish to confirm the input and display the geometry
in the View Input Geometry window. In this window, the geometry can be edited or completed
graphically as described in section 7.3. Of course, the Geometry menu options can also be
used for this purpose (section 4.3).

If the input contains errors, the Error Report window opens (when clicking the Finish button)
showing the list of encountered errors and giving for each of them a solution. Click Close to
close the Error Report window and use the Previous button of the New Wizard window to
change the data as required.

Geometry — Import

This option displays a standard file dialog for selecting an existing geometry stored in a ge-
ometry file, or in an existing input file for D-SETTLEMENT, D-GEO STABILITY (formerly known as
MStab), D-GEO PIPELINE (formerly known as MDrill) or MSEEP. For a full description of these
programs and how to obtain them, visit www.deltaressystems.com.

When selecting the geometry, it is imported into the current project, replacing the current
geometry. The imported geometry is displayed in the View Input window (Geometry tab). It
is also possible to use this option to analyze the settled geometry at different stages, as all
other input is retained.
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4.3.4 Geometry — Import from Database

4.3.5

4.3.6

This option displays the Select geometry dialog for importing a geometry from an existing
MGeobase database.

Select geometry @

Select

#=280%01
»=280402
H=280%03
»=280%04
H=280%05
H=2B0%0E
H#=200807
H=200%b1
H=200%02
#=280%03

Cancel | Help

Figure 4.7: Select geometry window

Again, the imported geometry will replace the current one and will be displayed in the View
Input window (Geometry tab).

Note: This option is only available when the correct database directory has been speci-
fied using the Locations tab in the Program Options window (see section 3.2.3). For more
information on MGeobase, visit www.deltaressystems.com.

Geometry — Export

This option displays a standard Save As dialog that enables to choose a directory and a file
name in which to save the current geometry. The file will be saved in the standard geometry
format for the Deltares tools. Files in this format can be used in a multitude of Deltares
geo-programs, such as D-GEO STABILITY (formerly known as MStab), D-SETTLEMENT (formerly
known as MSettle) and D-GEO PIPELINE (formerly known as MDirill). For a full description of
these programs and how to obtain them, visit www.deltaressystems.com.

Geometry — Export as Plaxis/DOS

This option displays the Save As Plaxis/DOS dialog that enables to choose a directory and a
filename in which to save the current geometry. The file will be saved using the old DOS-style
geometry format for the Deltares Systems Geo-programs. Files in this format can be used
by the finite element program Plaxis and in old DOS-based versions of Deltares Systems
Geo-programs such as D-GEO STABILITY (DOS) and MZet (DOS).

Saving files of this type will only succeed, however, if the stringent demands imposed by the
old DOS style are satisfied:

¢ number of layers < 20

< number of lines per boundary < 50
< total number of points < 500
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To be able to differentiate between an old DOS-style file and a normal geometry file, the file
dialog that prompts for a new file name for the old DOS-style geometry file provides a default
file name, prefixing the current name with a ‘D’.

Geometry — Limits

Use this option to edit the geometry limits.

Geometry Limits @

Geometny Limits

Boundary limit at left  [m]  |0.000
Boundary limit at right  [m]  |75.000

Cancel | Help |

Figure 4.8: Geometry Limits window

A limit is a vertical boundary defining the ‘end’ at either the left or right side of the geometry.
It is defined by an X co-ordinate only.

Note: A limitis the only type of element that cannot be deleted. The values entered here are
ignored if they resulted in an invalid geometry.

Geometry — Points

Use this option to add or edit points that can be used as part of layer boundaries.

E] Points @
jun |
B * Co-ordinate Y Co-ordinate
[m] [m]
A=
(2N 0.000 -10.000
-l 75.000 0,000
3 0.000 -8.000 | =
4 75.000 -8.000
5 0.000 -6.000
g 75.000 -6.000
i 0.000 -4.000
i g 75.000 -4.000
B 9 0.000 -2.000
0 75.000 -2.000
1 0.000 0.000
2 9.000 0.000
3 9.833 -1.000
4 10.667 1.000
5 11.500 0.000
5 14.500 0.000 -
Cancel | Help

Figure 4.9: Points window

A point is a basic geometry element defined by its co-ordinates. Since the geometry is re-
stricted to two dimensions, it allows defining an X and Y co-ordinate only.

Note: When a point is to be deleted, D-SETTLEMENT will check whether the point is used as
part of a layer boundary. If so, a message will be displayed.
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Confirm @

'.6.' At least one of the selected points is used in a boundary/Pl-Line/line.
\ ' Deleting such point(s) might result in deletion of

the boundaries/Pl-Lines/line using such point(s).

Continue this operation?

Figure 4.10: Confirm window for deleting used points

When Yes is clicked, all layer boundaries using the point will also be deleted. Every change
made using this window (Figure 4.9) will only be displayed in the underlying View Input window
(Geometry tab) after closing this window using the OK button. When this button is clicked,
a validity check is performed on the geometry. Any errors encountered during this check are
displayed in a separate window. These errors must be corrected before you can close this
window using the OK button. Of course, it is always possible to close the window using the
Cancel button, but this will discard all changes.

Geometry — Layers

This option enables to add or edit layers to be used in the geometry. A layer is defined by
its boundaries and its material. Use the Boundaries (seen here in Figure 4.11) to define the
boundaries for all layers by choosing the points that identify each boundary.

Layers @
Boundaries | b aterials |
O /201013
i -

1 §+c sﬁ:nltner ‘ #-Coar. ‘ -Coar.
g = DA M 0.000 0.000
: 2 12 9.000 0.000

! [ [3 |13 5873 41,000

5 | 4 14 10.667 -1.000
[ 15 11.500 0.000
£ |16 14.500 0.000
i 17 22500 2.500
g 18 26.500 2.500
=, g 19 34.500 5.000
B a |20 40.500 5.000
1 21 53.000 0.000
2|2 56.000 0.000

3|23 5E.833 -1.000

4 |24 57.6E7 -1.000
5 |25 58.500 0.000
E |26 75.000 0.000

Add Inzert *
Delete

ok, | Cancel Help

Figure 4.11: Layers window, Boundaries tab

On the left-hand side of the window, it is possible to add, insert, delete or select a boundary.
In the table on the right, it is possible to modify or add the points that identify the selected
boundary.

Note: It is only possible to manipulate the Point number column, because the co-ordinate
columns are purely for informative purposes. To manipulate the co-ordinates of the points,
select the Points option in the Geometry menu (see section 4.3.8).

Note: When inserting or adding a boundary, all points of the previous boundary (if this exists)
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are automatically copied. By default, the material of a new layer is set equal to the material of
the existing layer just beneath it.

The Materials to layers tab enables to assign materials to the layers.

Layers @
Boundaries  Materials |
Available materialz Layers

Mame | Murnber | Material hame |
Soft Clay 5 Dense Sand
Medium Clay | R
SHff Clay e Laooze Sand

|2 Soft Clay

Loose Sand 11 Gravel

Dersze Sand ;[:L
Sand

Gravel

Loam

Muck
Undetermined

>

Ok, | Cancel | Help |

Figure 4.12: Layers window, Materials tab

On the left of the screen, a list containing all defined materials (see the Materials option in
the Soil menu (section 4.2)) is displayed. On the right, a list of all defined layers together with
their assigned materials (if available) is displayed.The layers are listed from top to bottom as
displayed in the View Input window (Geometry tab).

j To assign a material to a layer, first select that layer on the right of the window. Then select
the required material on the left of the window. Finally, click the Assign button.

Every change made using this window will only be displayed in the underlying View Input
window (Geometry tab) after this window is closed using the OK button. When clicking this
button, a validity check is performed on the geometry. If errors are encountered, a dialog
window asks if auto-correction should be tried. Remaining errors are reported and can be
corrected manually. The error correction is confirmed by clicking the OK button and discarded
by clicking the Cancel button.

Geometry — Check Geometry

Select this option to verify the validity of the geometry. All requirements are checked. If the
geometry complies with all the requirements, a message will confirm this.

Information @

'6' The geometry has been tested and is ok.

Figure 4.13: Information window on confirmation of a valid geometry
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If any errors are encountered during this check, they are displayed in a separate window.

GeoObjects menu

GeoObjects — Discharges

In certain points in the element mesh, a constant discharge can be prescribed. The user has
to define the x- and y-coordinate and the discharge in m?/s. Before the calculation starts, the
discharge will be applied to the nearest node. Beforehand the user can look at the element
mesh, to find the coordinates of the desired node. A positive discharge means injection (a
well); a negative discharge means extraction (pump).

GeoObjects — Potentials

Instead of a discharge, the user can also specify a fixed potential in an internal point. The
potential refers to an elevation head at y = 0, where the atmospheric pressure is set to 0.

Note: Remarks on Discharges and Potentials

1 For discharges and potentials the user has to take into account that an internal point can
change position if it lies inside the ‘breathing’ block of the phreatic surface. Sometimes
a dummy layer boundary has to be specified to prevent this movement of points.

2 Due to the coarseness of the mesh, the user has to pay attention to the the following:

¢ the discharge of two or more wells or pumps can be set to the same nodal point.
The discharges will be added up;

< one or more prescribed potentials can be set to the same nodal point. Only the
last one is used;

¢ adischarge of a pump or well and the prescribed potential can be set to the same
node. The discharge will be removed and only the potential will be prescribed to
that node;

< inthe output file the nodes are marked with an arrow (<=) if one of these conditions
apply to that node.

GeoObjects — Sheet Piles

You can open the input window for forbidden lines either via the button at the left hand side
of the Input View window [section 2.2.3], or from the menu bar [section 2.2.1] (Geometry and
then choose Slip Circle Definition).

MSEEP uses forbidden lines as a constraint during the automatic determination of the critical
slip circle. The slip circle is not allowed to intersect with the forbidden line. You will use a
forbidden line for example to model a sheet piling.

In the geometry sheet piles can be defined. The X- and Y-coordinate of the top of the sheet
pile is assigned to a point in the top boundary and the required length has to be specified.
These coordinates must appear in the point table of the geometry. Only vertical sheet piles
are possible. A sheet pile may not be placed on the left or right side of the geometry. A
sheet pile may never cut the geometry into two parts and may never lie entirely outside the
geometry.

If any error occurs the number of boundary nodes of the element mesh will be incorrect.
When returning to the input menu, an ‘ERROR MESSAGE’ with ‘Number of boundary nodes
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is incorrect’ will appear. Sheet piles will be drawn in all plots with the exception of geometry
plots.

4.5 Water menu

4.5.1 Water properties

You can change the unit weight and the viscosity of water here.
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Calculations

On the menu bar [section 2.2.1], click Calculation to display the Start Calculation window.

Calculation — Start

Potential calculation

After the preparation of the input, the calculation of the potential in the nodal points of the
finite element mesh can be started. Within MSEEP different kinds of potential calculation can
be distinguished.

‘Cross section’ : Potential calculation without a phreatic surface

After having tested the input, the calculation starts and on the screen the three steps to solve
the differential equation are shown ( 1 - Create system matrix. 2 - Decomposition of system
matrix . 3 - Solve set of equations ). The results will finally be written to the output file and the
dump file.

‘Cross section’ : Potential calculation with a phreatic surface

After the calculation is started and the input is tested, two parameters have to be entered:

¢ The required accuracy : 1.00000E-3 (default value)
< Number of adjustments : 15 (default value)

The highest accuracy which can be inputed is 10 [m] and the minimum number of adjust-
ments is 3. The accuracy represent the maximum difference between the potential and the
elevation head allowed for all nodes on the phreatic surface (not on the seepage surface).

When the phreatic surface is not determined with a high accuracy, there will arise local unbal-
ance in the discharges of the nodes near the phreatic surface. Especially when a streamline
calculation is performed, this unbalance will disturb the picture of the streamlines.

The number of adjustments is not so important. When the accuracy is not reached within this
number, a question will be asked, to give a new number of adjustment.

During this iterative process to determine the position of the phreatic surface, the geometry
will be drawn on the screen with the old and new position of the phreatic surface. When
the required accuracy is reached the results are written to the output file and the dump-file.
Sometimes the accuracy will not be reached, because the phreatic block becomes to thin and
is adjusted to 5% of the original height.

The maximum error indicates the absolute greatest difference between the potential and the
elevation head in any of the phreatic nodes. Only engineering judgement can decide whether
the phreatic surface is realistic or not.

A phreatic surface can never drop through a boundary layer, as a result of the mesh being
adapted. This is one of the most important limitations of MSEEP. Also the accuracy will not
reduce if due to discharge (or rainfall), the phreatic surface (partly) coincides with the upper
boundary layer. The potential will sometimes be higher than the elevation head!!
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‘Phreatic aquifer’

Here too, two additional parameters have to be entered:

¢ The required accuracy : 1.00000E-3 (default value)

< Number of adjustments : 15 (default value)

The highest accuracy which can be inputed is 10 [m] and the minimum number of adjust-
ments is 3. The accuracy represents the maximum difference between the average elevation
head allowed for all nodes in to successive iterations.

The number of adjustments is not so important. When the accuracy is not reached within this
number, a question will be asked, to give a new number of adjustment.

During this iterative process to determine the transmissivity of all elements the geometry will
be drawn on the screen. When the required accuracy is reached the results are written to the
output file and the dump-file.

The maximum error indicates the average of the difference between the elevation head of all
nodes in two successive iteration steps.

The phreatic surface (or the elevation head per element) can never be less than 0.01 meter.
The area drops dry locally.

Note: With the function key <ESC> a calculation can be aborted. The process will finish
the current iteration (or adjustment step). The results will not be available when a calculation
is aborted
The output file is created each time the Start option in the Calculation menu is selected.
Viewing the file can be done by selecting the Report option in the Results menu. With the
keys, shown in the bottom line on the screen, the user can page through the file.
First of all the input data of the problems is written on the file, as it is interpreted by MSEEP.
Secondly the results per nodal point are written on the file:

¢ node number with x- and y-coordinate;

¢ the potential in the node;

& the discharge [m®/s], which flows through the nodal point. For internal nodes, or nodes

on a closed boundary or phreatic surface without rainfall, this discharge has to be zero!;

¢ type of node if node lies on boundary.

For each part of the outside border of the geometry the total discharge is calculated, except
for the vertex points.

This outline of the in- and outflow of the problem is very important, for interpreting the final
results.

Positive discharge means inflow, a negative discharge means outflow.

The output file is an ASCII file with extension .SED.
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6 View Results

6.1

6.2

On the menu bar, click Results to display the following menu options. You use these options
to view the results that were generated by the MSEEP calculation (chapter 5).

<& Report [section 9.3] to view a tabular report;
& Contour Potentials [section 9.4] to display a contour plot of the potential or the pressure.

Report Selection

On the menu bar, click Results and then choose Report Selection to open the corresponding
input window in which the content of the final report can be selected.

=8| F.eport Content

i [w]1 Tahle of Contents

E| V| 2 Input Data.

.21 Calculation

-] 2.2 Materials

- [w]2.3 Layers

- [v] 2.4 Water Properties

- [v] 2.5 Boundary Lines

i [v]2.6 Prescribed Modes
2-[¥3 Calculation Results

-] 3.1 Calculation Information
- [w]3.2 Calculated Discharges per Boundary
-] 3.3 Water Surface

- [v] 3.4 Calculated Made Data
-] 3.5 Velocities

¥ Page numbers in Table of Contents (slows down report generation)

SelectAll Deselect All

Figure 6.1: Report Selection window

Report

On the menu bar, click Results and then choose Report to open the Report window displaying
the selected results (section 9.2) of the calculation.

Click the Print active window button El on the icon bar to print the report.

Use the Export Report option in the File menu to export the report in RTF, PDF, TXT or HTML
format.

The report has its own toolbar:

Those four buttons enable the user to zoom in, to zoom out,
AN EH = to zoom the full page or to zoom the page width.

Those four buttons enable the user to browse through the
[ ¢ [ report by respectively moving to first page, moving to previous
page, moving to next page or moving to last page.
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Another way of quickly browsing through the report is by en-
Page [13 of 19 tering a page number in the input field on the toolbar and
pressing the Enter key.

The output file consists of the following elements:

¢ Input data
0 program name and version, update, company name, license and copy number;
O title of the problem;
0 names of the used files;
0 echo of the input;
¢ Calculation data

6.3 Contour Potentials

On the menu bar, click Results and then choose Contour Potentials to open the Contour Po-
tentials window displaying a contour plot of the potential (Figure 6.2), the velocity (Figure 6.3)
or the pressure (Figure 6.4).

A2 Contour Potentials [E=5 E=R ()

m| Fotential [m}

541m
582m
623 m
664 m
705m
746m
78Tm
828 m
869 m

-]

o

l
L

[E]
% 2.233

v:23.963 | |

Figure 6.2: Contour Potentials window, Potential results
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& Contour Potentials

Data.

Fotential [m}

541m
s82m
623m
664m
7.05m
7.46m
7.87m
828m
8.69m

[=le =

%:17.359 v 24500 [ [

& Contour Potentials

Data.

Pressure [m]

178m
356m
537Tm
7.16m
895m
10.74m
1253m
1432m
1641 m

(E=N B B

%:-30.756 v:24.423 [ [

Figure 6.4: Contour Potentials window, Pressure results
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7.1.1

7.1.2

Graphical Geometry Input

This chapter explains how to define the soil layers in a two-dimensional cross section by
drawing, using the shared D-Series options for geometry modeling.

<& section 7.1 introduces the basic geometrical elements that can be used.

<& section 7.2 lists the restrictions and assumptions that the program imposes during ge-
ometry creation.

<& section 7.3 gives an overview of the functionality of the View Input window.

¢ section 7.4 describes the creation and section 7.5 describes the manipulation of general
graphical geometry using the View Input window.

Besides graphical input, the geometry can also be imported or tabular forms can be used
(see section 4.3.2). See the MGeoBase manual for a description of special features to create
cross-section geometry semi-automatically from CPT and/or boring records.

Geometrical objects

Geometry can be built step-by-step through the repetitive use of sketching, geometry creation
and geometry manipulation. Each step can be started by using line-shaped construction ele-
ments (section 7.1.2) to add line drawings. After converting these drawings to valid geometry
parts, the specific geometry elements created can be manipulated (section 7.1.1).

Geometry elements

Geometry can be composed from the following geometry elements:

Points A point is a basic geometry element defined by its co-ordinates. As
stated earlier, the geometry is restricted to two dimensions, allowing to
define X and Z co-ordinates only.

Boundary lines A boundary line is a straight line piece between two points and is part
of a boundary.

Boundaries A boundary is a collection of connected boundary lines that forms the
continuous boundary between layers.

Layers A layer is the actual soil layer. Its geometrical shape is defined by its
boundaries, and its soil type is defined by its material.

Materials A material defines the actual soil material (or soil type). It contains the

parameters belonging to the soil type, such as its unsaturated weight
and its saturated weight. A material can be connected to a layer in
order to define the soil type of the layer.

Limits A limit is a vertical boundary defining the ‘end’ at either the left or right
side of the geometry. It is defined by an X co-ordinate only. Note that
this is the only type of element that cannot be deleted.

Adding, moving and deleting the above-mentioned elements are subject to the conditions for
a valid geometry (see section 7.2). For example, while dragging selected geometry elements,
the program can perform constant checks on the geometry validity (section 7.4.4). Invalid
parts will be shown as construction elements (thick blue lines).

Construction elements

Besides the D-Series geometry elements (section 7.1.1), special construction elements can
also be used for sketching the geometry graphically. These elements are not a direct part of
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the geometry and the restrictions on editing (adding, moving, and deleting); these elements
are therefore far less rigid. The only restriction that remains is that these elements cannot be
moved and/or defined beyond the limits of the geometry.

Lines A line Construction consists of a starting point and end point, both de-
fined by a left-hand mouse click in the graphic input screen.

Poly-lines A poly-line Construction consists of a series of connected lines, all de-
fined by a left-hand mouse click in the graphic input screen.

Construction elements will be displayed as solid blue lines. Valid constructions elements
are converted to geometry elements as soon as the geometry is (re-) generated. For more
information on adding lines and poly-lines, see section 7.4.

Assumptions and restrictions

During geometrical modeling, the program uses the following assumptions.

Boundary number 0 is reserved for the base.

A soil layer number is equal to the boundary number at the top of the layer.

The boundary with the highest number defines the soil top surface.

A material (soil type) must be defined for each layer — except for layer 0 (base). Different
layers can use the same material.

All the boundaries must start and end at the same horizontal co-ordinates.

Boundaries should not intersect, but they may coincide over a certain length.

All horizontal co-ordinates on a boundary must be ascending — that is, the equation
X[i+ 1] > X[i] must be valid for each following pair of X co-ordinates (vertical parts
are allowed).

¢ Layer boundaries may intersect.

C OO0

C 00

One way for inputting geometry data is through the Geometry menu, as explained in the
Reference section (section 4.3). This section describes an other way to create and manipulate
geometry graphically using the tool buttons of the View Input window.

View Input Window

General

To use the View Input option, click the Geometry tab to activate it in the regular View Input
window or use the menu to select it.
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2 viewinput [E=mEn
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Figure 7.1: View Input window, Geometry tab

When the Geometry tab in the View Input window is selected, it displays a graphical repre-
sentation of only the geometrical data. On the left of the window, the Edit and Tools buttons
are displayed (section 7.3.2). On the right, the legend belonging to the geometry is displayed
(section 7.3.3). At the bottom of the window, the title panel and the info bar are displayed.
The title panel displays the project titles defined using the Properties option in the Project
menu. The info bar provides information (from left to right) about the current cursor position,
the current mode and the object currently selected. The legend, title panel and info bar are
optional and can be controlled using the Properties option in the Project menu.

It is possible to use three different modes when working in the Geometry tab of the View Input
window:

Select The Select mode is the default mode and enables the user to select existing
elements in the window.
Add The Add mode allows the addition of elements using one of the Add buttons.

By selecting one of these buttons, one switches to the Add mode. As long as
this mode is active, the user can add the type of element which is selected.

Zoom The Zoom mode allows the user to view the input geometry in different sizes.
By selecting one of the Zoom buttons or the Pan button, one activates the
Zoom mode. While in this mode, the user can repeat the zoom or pan actions
without re-selecting the buttons.

It is possible to change modes in the following ways. When in Add or Zoom mode, it is
possible to return to the Select mode by clicking the right-hand mouse button, or by pressing
the Escape key, or by clicking the Select mode button. To activate the Add mode, select one
of the Add buttons. To activate the Zoom mode, select one of the Zoom buttons or the Pan
button.

Note: The current mode is displayed on the info bar at the bottom of the View Input window.
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7.3.2 Buttons

Edit panel:

(A

44 of 63

Select and Edit mode

In this mode, the left-hand mouse button can be used to graphically select a pre-
viously defined grid, load, geotextile or forbidden line. Items can then be deleted
or modified by dragging or resizing, or by clicking the right-hand mouse button and
choosing an option from the menu displayed. Pressing the Escape key will return
the user to this Select and Edit mode.

Pan

Click this button to change the visible part of the drawing by clicking and dragging
the mouse.

Add point(s) to boundary / PL-line

Click this button to add points to all types of lines (lines, poly-lines, boundary lines).
By adding a point to a line, the existing line is split into two new lines. This provides
more freedom when modifying the geometry.

Add single lines(s)

Click this button to add single lines. When this button is selected, the first left-hand
mouse click will add the info bar of the new line and a “rubber band” is displayed
when the mouse is moved. The second left-hand mouse click defines the end point
(and thus the final position) of the line. It is now possible to either go on clicking start
and end points to define lines, or stop adding lines by selecting one of the other tool
buttons, or by clicking the right-hand mouse button, or by pressing the Escape key.
Add polyline(s)

Click this button to add poly-lines. When this button is selected, the first left-hand
mouse click adds the starting point of the new line and a “rubber band” is displayed
when the mouse is moved. A second left-hand mouse click defines the end point
(and thus the final position) of the first line in the poly-line and activates the “rubber
band” for the second line in the poly-line. Every subsequent left-hand mouse click
again defines a new end point of the next line in the poly-line. It is possible to end
a poly-line by selecting one of the other tool buttons, or by clicking the right-hand
mouse button, or by pressing the Escape key. This also stops adding poly-lines al-
together.

A different way to end a poly-line is to double-click the left-hand mouse button. Then
the poly-line is extended automatically with an ‘end line’. This end line runs horizon-
tally from the position of the double-click to the limit of the geometry in the direction
the last line of the poly-line was added. Therefore, if the last line added was defined
left to right, the ‘end line’ will stop at the right limit. Note that by finishing adding a
poly-line this way, it is possible to start adding the next poly-line straight away.
Zoom in

Click this button to enlarge the drawing, then click the part of the drawing which is to
be at the center of the new image. Repeat if necessary.

Zoom out

Click this button, then click on the drawing to reduce the drawing size. Repeat if
necessary.

Zoom rectangle

Click this button then click and drag a rectangle over the area to be enlarged. The
selected area will be enlarged to fit the window. Repeat if necessary.

Measure the distance between two points

Click this button, then click the first point on the View Input window and place the
cross on the second point. The distance between the two points can be read at the
bottom of the View Input window. To turn this option off, click the escape key.
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Tools panel:
Undo zoom
7| Click this button to undo the zoom. If necessary, click several times to retrace each

consecutive zoom-in step that was made.
Zoom limits
Click this button to display the complete drawing.

Same scale for X and Y axis
Click this button to use the same scale for the horizontal and vertical directions.

Automatic regeneration of geometry on/off

B3| When selected, the program will automatically try to generate a new valid geometry
~—  whenever geometry modifications require this. During generation, (poly)lines (solid
blue) are converted to boundaries (solid black), with interjacent layers. New layers
receive a default material type. Existing layers keep the materials that were assigned
to them. Invalid geometry parts are converted to construction elements.

Automatic regeneration may slow down progress during input of complex geometry,
because validity will be checked continuously.

Undo

Click this button to undo the last change(s) made to the geometry.

Redo
Click this button to redo the previous Undo action.

2

Delete

#. | Click this button to delete a selected element. Note that this button is only available
when an element is selected. See section 7.5.2 for more information on how using
this button.

7.3.3 Legend

At the right side of the View Input window (Figure 7.2) the legend belonging to the geometry
is shown. This legend is present only if the Legend check-box in the View Input tab of the
Project Properties window is activated (see section 4.1.2).

2 Viewlnput [E=n men >
Geomety nput | Boundary Conditions | Erosion | Mesh
Edit_# T [ [ [ [ hnnnnnn [Rannnn [leo . oy I— R L I Layers
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Tool ﬁ ; 7
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=
= 60000 50.000
?‘ o
#7.021 [Y:23.848 Edit Current ohject None

Figure 7.2: View Input window, Geometry tab (legend displayed as Layer Numbers)

In the Geometry tab of the View Input window, it is possible to change the type of legend.
When a soil type box in the legend is right clicked, the menu from Figure 7.3 is displayed.
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w Layer Numbers
Material Mumnbers
Matetial Mamas

Figure 7.3: Legend, Context menu

With this menu, there are three ways to display the legend of the layers:

& As Layer Numbers: the legend displays one box for each layer. Each layer (and there-
fore each box) is displayed in a different standard color. Next to each box, the layer
number and the material name are displayed, corresponding to the color and number
of the layer in the adjacent Geometry window (see Figure 7.2).

& As Material Numbers: the legend displays one box for each material. Each material
(and therefore each box) is displayed in a different color which can be changed by
the user (see below). Next to each box, the material number and name are displayed,
corresponding to the color and number of the material in the adjacent Geometry window
(see Figure 7.4).

& As Material Names: the legend displays one box for each material. Each material (and
therefore each box) is displayed in a different color which can be changed by the user
(see below). Next to each box, only the material name is displayed, corresponding to
the color and name of the material in the adjacent Geometry window (see Figure 7.5).
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Figure 7.4: View Input window, Geometry tab (legend displayed as Material Numbers)
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Figure 7.5: View Input window, Geometry tab (legend displayed as Material Names)

Unlike the standard colors used to display layers with their layer colors, it is possible to define
different colors used when displaying materials. To change the color assigned to a material,
right click the material box. The menu from Figure 7.6 is displayed.

Properties...
Material Colors...

Layer Mumbers
Material Mumnbers

v Material Mames

Figure 7.6: Legend, Context menu (for legend displayed as Materials)

When selecting Material Colors the Color window appears (Figure 7.7), in which the user can
pick a color or even define customized colors himself (by clicking the Define Custom Colors
button).

21|
Basic colors:
ol | it
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| Dol ol ||
Al B0l
L0l
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Custom colors:
.I_I_I_I_I_-- Hue'l'l? Hed'l
-I_.-I_I_-- ’7 Satlm Greenlﬁ
Define Custan Colors »> ColorlSolid | Iﬁ Blue: Iﬁ
Cancel | Add ta Custom Colors |

Figure 7.7: Color window

Geometry modeling

Create a new geometry

There are two ways to create a new geometry without the wizard:
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& Open the Geometry menu and choose New.
¢ Open the File menu and choose New. In the New File window displayed, select New
Geometry and click OK (see section 4.3.2).

In both cases, the Geometry tab of the View Input window is displayed (Figure 7.8) with the
default limits of the geometry (from 0 to 100 m).
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Figure 7.8: View Input window, Geometry tab

7.4.2 Set limits

The first thing to do when creating new geometry is to set the model limits. This is possible by
selecting and then dragging the limits to their proper place one by one. It is also possible to
select a limit and edit its value by clicking the right-hand mouse button after selecting the limit
and then choosing the Properties option in the pop-up menu. The property window belonging
to the selected limit is displayed (Figure 7.9), enabling to define the new X co-ordinate for this
limit.

x4
Limit &t right side: [m] |?5. 0aa
Ok I Cancel |

Figure 7.9: Right Limit window
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7.4.3 Draw layout

It is possible to use the Add single line(s), Add polyline(s) and Add point(s) to boundary / PL-
line buttons to draw the layout of the geometry. See section 7.3.2 for more information’s on
how using those buttons.

Add single line(s) = and Add polyline(s) ==

Each (poly)line is displayed as a solid blue line, and each point as a small black rectangle
(Figure 7.10).

Figure 7.10: Representation of a polyline

The position of the different points of a (poly)line can be modified by dragging the points as
explained in section 7.5.4 or by editing the (poly)line. This is done by clicking the right-hand
mouse button after selecting the (poly)line and then choosing the Properties option in the
pOop-up menu.

The underlying grid helps the user to add and edit (poly)lines. Use the Properties option in
the Project menu to adjust the grid distance and force the use of the grid by activating Snap to
grid. When this option is activated, each point is automatically positioned at the nearest grid
point.

The specified line pieces must form a continuous line along the full horizontal width of the
model. This does not mean that each line piece has to be connected exactly to its predecessor
and/or its successor. Intersecting line pieces are also allowed, as shown in the examples of
Figure 7.11.

| |

(1) =l (@)= = @S

Figure 7.11: Examples of configurations of (poly)lines

<& Configuration (1) is allowed. The different lines are connected and run from boundary
to boundary

¢ Configuration (2) is also allowed. The different are connected. They are defined as
being connected because they intersect. The line construction runs from boundary to
boundary.
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¢ Configuration (3) is illegal, as there is no connection with the left boundary.

Add point(s) to boundary / PL-line =

Use this button to add extra points to lines (lines, polylines, boundary lines). By adding a
point to a line, the existing line is split into two new lines. This provides more freedom when
modifying the geometry.

Note: When the Add point(s) to boundary/PL-line button is clicked, each left-hand mouse
click adds a new point to the nearest line until one of the other tool buttons is selected, or click
the right-hand mouse button, or press the Escape key.

Generate layers

Use the Automatic regeneration of geometry on/off button Bl to start or stop the automatic
conversion of construction elements to actual boundaries and layers. Valid (poly)lines are
converted to boundaries, which are displayed as black lines. Invalid lines remain blue.

Layers are generated between valid boundaries, and default soil types are assigned.

It is possible to modify the soil type assigned to a layer by first selecting the layer and then
clicking the right-hand mouse button and choosing the Layer Properties option in the pop-
up menu to display the Layer window (see Figure 7.19 in section 7.5.3). Once a material
has been assigned to a layer, this material will continue to be associated to that layer in
subsequent conversions of construction elements as long as the layer is not affected by those
conversions.

The most common cause of invalid (poly)lines is that they are not part of a continuous poly-
line running from limit to limit. Sometimes, lines appear to start/end at a limit without actually
being on a limit. Figure 7.12 gives an example: on the left geometry (1), the end of the line
seems to coincide with the boundary. However, zooming in on the point (geometry (2) on the
right) reveals that it is not connected to the boundary. Therefore the geometry is considered

L —

(1) (@)

Figure 7.12: Example of invalid point not connected to the left limit

It is possible to correct this by dragging the point to the limit while the specific area is zoomed
in or by selecting the point, clicking the right-hand mouse button, choosing the Properties
option in the pop-up menu (section 7.5.3) and making the X co-ordinate of the point equal to
the X co-ordinate of the limit.

Graphical manipulation

Selection of elements

After selecting a geometry element it is possible to manipulate it. In order to be able select a
geometry element, the select mode should be active. Then it is possible to select an element
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by clicking the left-hand mouse button. To select a layer, click on the layer number, material
number or material name, depending on the option chosen in the Properties dialog in the
Project menu. When successfully selected, the element will be displayed highlighted (for
example, a point will be displayed as a large red box instead of a small black box).

The following remarks are relevant to selection accuracy and ambiguity.

Ambiguous selection

A selection of geometrical elements can be ambiguous. Figure 7.13 gives an example: a user
may want to select a point, a boundary line or a boundary. As several elements are in close
proximity to each other,

mseep does not automatically select an element.

Figure 7.13: Selection accuracy as area around cursor

In this case

mseep requires the user to assign the element that is to be selected by displaying a pop-up
menu (Figure 7.14) with the available types of elements within the range of the selection click.
It is possible to select the element from this menu.

Seleck PL Line 1

Seleck PL Line 2
Select Boundary Line

Figure 7.14: Selection accuracy as area around cursor

Clear selection

It is possible to clear a selection by clicking in an area without geometry elements in the direct
area.

Deletion of elements

Click the Delete button X! to delete a selected element. This button is only available when an
element is selected.

When a point is selected and deleted, it and all lines connected to it are deleted as shown in
Figure 7.15.
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Before After

Figure 7.15: Example of deletion of a point

When a geometry point (a point used in a boundary) is selected and deleted, the program
deletes the point and its connected boundary lines as shown in Figure 7.16. It then inserts a
new boundary that reconnects the remaining boundary lines to a new boundary.

A /
/ 7
/ 7
Before &= After &

Figure 7.16: Example of deletion of a geometry point

Deletion of a geometry element (boundary, boundary line, geometry point) can result in auto-
matic regeneration of a new valid geometry, if the Automatic regeneration option is switched
on.

When a line is selected and then deleted, the line and its connecting points are deleted as
shown in Figure 7.17. In addition the layer just beneath that boundary is deleted. All other line
parts that are not part of other boundaries will be converted to construction lines.

After

Figure 7.17: Example of deletion of a line

Before
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7.5.3 Using the right-hand mouse button

When using the mouse to make geometrical manipulations, the right mouse button enables
full functionality in a pop-up menu, while the left button implies the default choice. The options
available in the pop-up menu depend on the selected geometrical element and the active
mode.

When the Select mode is active and the right-hand mouse button is clicked, the pop-up menu
of Figure 7.18 is displayed.

Properties...

Delete Del
Unda Chrl+Z
Redo Chrl+y

iew Preferences. ..
Skatistics

Lawer Propetbies. ..
Delete Allllogse Lines

Delete All Loose Paints

Figure 7.18: Pop-up menu for right-hand mouse menu (Select mode)

Properties... When this option is clicked, the property editor for the selected object
is displayed. This procedure is performed by first selecting an object by
clicking on it with the left-hand mouse button. Then clicking the right-
hand mouse button anywhere in the graphic window will display the
pop-up menu. It is possible to use the property editor to quickly adapt
the values (properties) of the selected object. Each type of element
requires its own properties and therefore its own property editor as
shown from Figure 7.20 to Figure 7.22 below.

Delete This option deletes the element that has been selected (see the com-
ments for the Delete button in section 7.5.2).

Undo This option will undo the last change(s) made to the geometry.

Redo This option will redo the previous Undo action.

View This option opens the Properties dialog in the Project menu as dis-

Preferences... played in.

Statistics It is possible to use this option to view a window displaying all the vital

statistics of the input data. Note that in the window construction lines
are called free lines.

Layer This option is a special feature that edits the material properties of lay-

Properties... ers. It is possible to click anywhere in a layer and directly choose this
option to edit its properties (Figure 7.19). Clicking outside the geometry
layers will display the menu with the Layer Properties option disabled,
as there is no layer for which properties can be displayed.

Delete All Loose  This option will delete all loose lines. Loose lines are actually con-

Lines struction lines that are not part of the boundaries (therefore, all lines
displayed as solid blue lines). With this option, it is possible to quickly
erase all the “leftover bits” of loose lines that may remain after convert-
ing lines to a geometry.

Delete All Loose  This option will delete all loose points.

Points
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x|
Material type : |W:l'

Information on current material type
Unit weight, dry [kM /] 14.00
Unit weight, wet [kM Ani] 14.00

oK I Cancel |

Figure 7.19: Layer window (Property editor of a layer)

x
# co-ordinate: [rm] IW
Z co-ordinate [m] IW
' co-ordinate [rm] IW

ak I Cancel |

Figure 7.20: Point window (Property editor of a point)

x

=
B Paint # Co-ordinate | £ Co-ordinate
3 Mumber [m] [m]
Fig
L3N] 12 0.000 -4.000
[ 2 15 36906 4657
—1 13 20 46965 -7.000
4 A 75.000 -7.000
*
iy

Cancel | Help |

Figure 7.21: Boundary window (Property editor of a polyline)

Boundary Line 1 x|

Pairt 5
X oco-ordinate  [m] |8.382

Z co-ordingte  [m] |-1.053

Faint &

¥ coordinate  [m) |41.4DD

Zcoordinate  [m] |-0.716

Length [rn] |35.D4D
Slope [%] |1 0

Cancel |

Figure 7.22: Boundary window (Property editor of a line)

Note: In the Boundary properties window, only the point’s number can be modified, not the
X and Z co-ordinates.
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7.5.4 Dragging elements

One way to modify elements is to drag them to other locations. To drag an element, first select
it. Once the element has been selected, it is possible to drag it by pressing and holding down
the left-hand mouse button while relocating the mouse cursor. Dragging of geometry elements
can result in automatic regeneration of geometry, if this option is switched on (section 7.4.4)
as shown in the example of Figure 7.23: when the selected point is moved upwards, a new
geometry will be created.

mseep creates new layers according to this new geometry.

Before After

Figure 7.23: Example of dragging of a point
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8 Examples

The following examples are discussed below:

<& cross section example [section 8.1]
<& phreatic aquifer example [section 8.2]

For these examples the following is presented:

<& output file including an echo of the input and the calculation results;
¢ a drawing representing geometry and the boundary conditions;

¢ adrawing giving the element mesh and the deformed mesh;

¢ a drawing giving the iso-potential lines.

8.1 Example 1: Cross example

In example 1, the ‘cross section’ method is used to calculate the phreatic surface of a homo-
geneous soil layer. An internal point with a fixed potential has been defined on the bottom
layer; with coordinates (50, 0).
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Example 2: Aquifer example

Example 2 is the phreatic aquifer of example 1. In the centre of the geometry one point
(50, 20) has been given with a fixed potential. The difference is obvious. To compare the two
methods, example 3 has been added.
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9.1

Background information
Below, you will find background information on the following topics:

<& Darcy’s Law [section 9.1];

<& Cross section model [section 9.2];

<& Phreatic aquifer model [section 9.3];

<& Pore pressure used in MSEEP [section 9.4].

Darcy’s Law

Darcy’s law gives a relation between the specific discharge ¢ and the hydraulic gradient along
a streamline s for laminar flow:

q=—k-dy/ds (9.1)

The constant k is the hydraulic permeability and depends on soil properties and the pore-
fluid. Darcy’s law is valid as long as the Reynolds number (Re) does not exceed some value
between 1 and 10.

Re=qgx D/v (9.2)
where:
v viscosity water
D medium grain size

The soil structure can be composed of several soil layers divided by layer boundaries. The
permeability has to be specified for each layer.

An indication of the permeability for different kinds of soils:

gravel : 0.1 -0.01 m/s
gravel sand : 0.01 -1.0E-5 m/s
fine sand/silt  :1.0E-5 -1.0E-8 m/s
peat : 0.001 - 1.0E-6 m/s
layed clay :1.0E-6 -1.0E-9 m/s
fine clay :1.0E-8 -1.0E-10 m/s

The user of MSEEP has to take into account that real soil layers are never homogeneous. The
above list of permeabilities give a rough indication.

When the permeability k in the porous medium differs in some points, the medium is so-called
inhomogeneous. If k& only depends on the x- or y- direction, the medium is anisotropic.

The potential is a handsome quantity, because it doesn’t depend on the gravity forces in the
flowfield. Horizontal and vertical flow have the same parametical relation. The actual pressure
can be calculated easily if the potential is known. The following relation holds:

o =p/pg+y (9.3)

or in words : piézometric head = pressure head + elevation head

where:
is the unit weight of the fluid;

is the acceleration of the gravity;

is the potential or piézometric/hydraulic head
is the elevation head

is the water pressure

"e gD
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Cross section model

Using the continuity equation and Darcy’s law, the Laplace equation is found for the description
of two dimensional steady flow:

0 Op 0 Op
— | = — — | = — ] = 4
o ( kz 835) + 3y ( ky ay) Q (9.4)

where:
k, and k,  are the permeabilities in x- and y-directions;

is the (prescribed) discharge along the boundaries or the discharge of internal
sources

The above differential equation is solved in MSEEP by using the finite element method (see
(See)).

The position of the phreatic surface is unknown beforehand. MSEEP determines the phreatic
surface on an iterative way, by using the two boundary conditions along this surface: the
phreatic surface is a streamline and the pressure is equal to the atmospheric pressure.

During this iterative process, for each node on the phreatic surface or seepage face the quan-
tity and direction of the specific discharge will be determined.

A negative discharge means, within MSEEP, an outflow and so the concerning nodal point
belongs to the seepage face.

The finite element mesh will be adapted each step until the phreatic surface satisfies both
conditions.

In this manual, this will be called ‘the breathing’ of the element mesh (see (Verruyt)), and can
finally result in a deformed element mesh (see graphical output).

Phreatic aquifer model

The geometry of most aquifers is such that they are thin relative to their horizontal dimensions
(see (Bear, 1979)).

In 1863 Dupuit based his assumptions on the observation that in most groundwater flows,
the slope of the phreatic surface is very small. This assumption is equivalent to assuming
the equipotential surface are vertical and the flow is essentially horizontal. De vertical flow
components are neglected.

The discharge per unit width in the aquifer is:

g=-TxA_ (9.5)
where:
T transmissivity (i.e. k._2);
A is the elevation head;
k is the permeability.

Using the continuity equation and the discharge, we obtain for an inhomogeneous anisotropic
aquifer.

0 Op 0 dp\
w(rE) 5 (ng) e .
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where:
T, is the transmissivity in x- and y-direction;
k., k,  are permeabilities in x- and y-direction;
Q is the prescribed discharge along the boundaries or internal sources.

The above non-linear equation is solved in MSEEP by linearization and using the finite element
technique. The transmissivity depends on the elevation head _, which is unknown beforehand.
MSEEP solves it on an iterative way, by assuming that at the first iteration the transmissivity is
equal to the permeability (So the elevation head is equal to 1 m.). Each step the transmissivity
is updated in each element of the mesh, using the calculated hydraulic head _.

The phreatic boundary condition is now incorporated in the equation of flow in the aquifer.
This is referred to as the hydraulic approach.

Pore pressure used in MSEEP

MSEEP offers the following methods to supply the pore water pressure for the stability program
D-GEO STABILITY. MSEEP determines the phreatic surface and the pore pressures at the lateral
boundaries of the slices directly from the imported data.
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